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Information in this document is subject to change without notice. No part of this 
document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose without the express written consent of Information 
Integration Group, Inc. 
 
TRADEMARKS 
 
MS-DOS and Windows are trademarks of Microsoft Corporation. 
 
MAS 90, MAS 90CS, MAS 90W and MAS 200 are registered trademarks of Sage 
Software, Inc. 
 
True Commerce, True Commerce Integrator, and TC.NET are the registered trademarks 
of True Commerce, Inc. 
 
All other product names and brand names are service marks, and/or trademarks or 
registered trademarks of their respective companies. 
 
REQUIREMENTS 
 

• True Commerce Integrator version 3.2 build 0010 (or above) AI Package with 
Labels. 

• MAS 90 (IIG).BSP version 0008 or above (supplied by True Commerce). 
• Bartender 7.0 Professional (usually supplied with Integrator). 
• Compatible Bar Code printer for ASN Labels.  We highly recommend Zebra 

printers, but any compatible thermal label printer will do.  Laser printers are 
also supported but not recommended for high volume. 

• Internet Connection.  DSL or above recommended but not required. 
• Workstation hosting the Integrator must have a mapped drive to the MAS 90 

folder. 
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Installation Instructions and Cautions 

PLEASE NOTE: MAS 90 must already be installed on your system before 
installing any IIG enhancement. If not already done, perform your MAS 90 
installation and setup now; then allow any updating to be accomplished 
automatically. 
 
Once MAS 90 installation and file updating is complete, you may install your IIG 
enhancement product by following the procedure below. 
 

Wait! Before You Install – Do You Use 
CUSTOM OFFICE? 

THIS IS AN IMPORTANT CAUTION:  If you have Custom Office installed, 
and if you have modified any MAS 90 screens, you must run Customizer Update 
after you do an enhancement installation.  
 
But wait! BEFORE you run Customizer Update, it is very 
important that you print all of your tab lists. Running 
Customizer Update will clear all Tab settings; your printed 
tab list will help you to reset your Tabs in Customizer 
Update. 
Custom Office is installed on your system if there is an 
asterisk in the title bar of some of the screens. The asterisk 
indicates that the screen has been changed. 
 
 
 

         

An asterisk in a 
window’s title bar 
indicates that the 
screen has been 
modified. This 
means that 
Custom Office is 
installed. 
 
Follow all the 
instructions on 
this page before 
you run 
Customizer 
Update! 
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Registering IIG products 

IIG Enhancement should be registered to be able to use it. If registration is not performed, 
the enhancement will work in a demo mode for a limited time period. The registration 
can be still done during the demo period. 
 
Select the IIG Product Registration program under the Library Master Setup 
menu of the MAS 90. 
 
If this option is not listed under the Library Master Setup menu, go to the main 
menu, and select Run from the File menu. Type in SVIIGR and click OK. 
 

 
 
Enter Serial Number and Unlocking Key provided by IIG, and click OK. 
 
If multiple IIG Enhancements are installed, Serial Numbers and Unlocking Keys 
should be entered for each enhancement. 
 
IIG Registration Form can be printed by using the Print Registration Form 
button. 
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Setting up EDI Maestro for True Commerce 
 
After installing the IIG True Commerce EDI Integration Enhancement, you will need 
to set up the IIG True Commerce EDI Options, added under the Sales Order Setup 
menu. 
 

 
 
Company EDI Identifier:   This is the normal company identifier that True Commerce 

will use.  Normally, it will be “12” plus your main 
telephone number. 

 If not specified, the IIG True Commerce Invoice Export 
will not be available. 

 
Factoring? This will be enabled if IIG Factoring module is installed. 
 
Sales Order Default Prefix: This is the default prefix to separate EDI orders from your 

normal order sequence.  You may enter “00” to force the 
system to use all seven digits as a normal sales order 
number. 

 
Next Default EDI Sales Order No.: This will be the next sales order number to use. 
 
810 Export Directory: This is the directory, on the MAS 90 Server that the 

invoices will be exported to for the True Commerce 
Integrator to import from.  The default directory used will 
be the TC_OUT directory. 
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Backup Out Directory: This is the directory that Ship To addresses and Inventory 
Items (if the IIG UPC module is installed) will be exported 
to in the format that the True Commerce Integrator will 
be expecting.  The default directory used will be the 
TC_BO directory. 

 
For both of the Directory fields above you can click on the  button to locate the folder 
on the server. 
 

 
 
Highlight the directory you wish to use, and the program will load the full path for the 
MAS 90 Server: 
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The Enable TSA check box has been added to the IIG True Commerce EDI Options 
screen. If that check box is not selected, the following message box is displayed when 
opening the IIG True Commerce ASN Export program under the Sales Order Main 
menu. 
 

 
 
After selecting the Enable TSA check box, the Next ASN Number, UCC Qualifier, 
Company UCC Code, Package Indicator, Next UCC Carton Number and Next UCC 
Serial Number fields will become visible. 
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Setting Up True Commerce for EDI Maestro 
 
Start True Commerce Integrator: 
 

 
 
Select File, then User Information. 
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On the Plug-in tab, verify that the Accounting Package is MAS90 (IIG). 
Next, select the Data tab: 
 

 
 
Click on the Edit Lookup Tables… button. 
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Select User ID and click the Open button. 
 

 
 
Enter the user ID used for importing.  We suggest either TCE or EDI. 
 
Click Ok to save this value, then click on the Close button to update. 
 
Next, click on the Export Files tab. 
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Click on the Change… button to modify the export path for Integrator. 
 

 
 
Select the TC_IN folder under the MAS90 folder, on the MAS 90 server.  This means 
that the True Commerce machine must have a mapped drive to the MAS90 folder.  Either 
your reseller or our Network Services Department can assist you in setting up a mapped 
drive if needed.  Click the OK button to save the Export Directory. 
 
Note:  You must actually click on the TC_IN folder, so it looks similar to the picture 
above. 
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Next, click on Warn Prior to Clearing Older Exported Files from Directory so that it 
is checked. 
 

 
 
Next, click on Use unique file name (date/time stamp) so that it is checked. 
 
 
 
Next, click on the Import Files tab: 
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Click on the Change… button next to the Import Directory field to change it to the 
TC_OUT folder under the MAS90 folder.  Remember that you must actually click on the 
TC_OUT folder to select it. 
 
Click on the Use File Archiving check box to turn it on.  We suggest that you set the 
Remove Files From Archive that are More Than to 60 Days or greater. 
 
Click on the Change… button next to the Directory field (under Archive File After 
Importing) to change it to the TC_ARC folder under the MAS90 folder.  Remember that 
you must actually click on the TC_ARC folder to select it. 
 
Import File Selection must be set to Import All Files in Directory. 
 
Click on the OK button to save these settings. 
 
Note:  These settings are what is required for the IIG True Commerce Integration.  There 
are additional steps in setting up True Commerce, which are covered in the True 
Commerce documentation.  Setting up Bartender and communications are covered in 
those manuals.
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Setting Up EDI Customers in MAS 90 
 
Now, go to A/R Customer Maintenance, and add or select your EDI customer, which 
will be your trading partner.  In the example below, we are using Bed Bath and Beyond. 
 

 
 
If you are adding the trading partner, you will need to enter all of the Ship-To Addresses 
for the trading partner.  These typically are the store addresses and the distribution 
centers. 
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An example: 
 

 
 
After all of the Ship-To Addresses are keyed in, select the Additional Tab: 
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Click the EDI button to access the IIG True Commerce EDI Customer Options: 
 

 
 
EDI Customer? Check to activate this customer as a Trading Partner. 
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Send C/M? Check to send credit memos.  Please note that this is 
trading partner specific.

 
Send D/M? Check to send Debit Memos.  As with Credit Memos, this 

will be trading partner specific. 
 
Factored? If enabled, indicates that this account is selectable for 

factoring. 
 
Vendor Number: Enter your vendor number with this trading partner. 
 
Sales Order Prefix: Enter the prefix that will be used for this trading partner. 
 
Next EDI SO Number: Enter the next EDI sales order number for this account.  

The system will check A/R history to insure that the system 
does not duplicate order numbers.  Default starting is 
00001. 

 
Ship-To => Button Click on this button to display the Ship-To Addresses 

Export screen. 
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Ship-To Addresses Export 
 

 
 
There are two ways to export.  You may select a range of addresses (up to about 200) and 
click on the Export button.  Due to the limitations of Windows, if you need to export 
more than that, you must select the Export All button. 
 
To select a range, select and highlight the first record of the range.  Then, scroll down 
until you reach the end of the range you are interested in.  Holding down the Shift Key, 
click on the ending address code.  The system will highlight the range, and then you can 
click on the Export button to export the addresses. 
 
The program will export the addresses into a CSV file into the directory specified in the 
Directory field. 
 
The name of the file will be the customer name, in the TC_BO directory: 
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Once you have exported the Ship-To Addresses, then click OK.  Then click Accept for 
the Customer information. 
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Exporting Items for Integrator 
You can export the items for the selected customer to have the Translation used in the 
Integrator. 
 
In the Customer Maintenance program, select the Customer: 
 

 
 
Click the Items… button. 
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On the Detailed Sales History screen, click the Alias… button: 
 

 
 
Enter Item Aliases that will be used in the Integrator, then click the Export button. 
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You can select the Directory or use the default, which is populated from the Backup 
Out Directory field in the IIG True Commerce EDI Options. 
 
From the Export To drop-down list, select Vendor Item # or SKU #, which designates, 
how the alias will be used in the Integrator. 
 
Select the lines to be exported, and click the Export button. 
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Setting up the Customer in Integrator 
 
Start up True Commerce: 
 

 
 
Click on the Trading Partners folder. 
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Select a trading partner.  In this example we will use Bed Bath and Beyond. 
 

 
 
Note:  Do not make any changes on the Main tab of the Electronic Partner Plug-in.   
 
Click on the Accounting tab. 
 

 
 
Accounting ID Enter the full MAS90 Customer Number of the trading partner. In    

this example, the customer ID is 50-BED001.You would enter 
500BED001 number as the Accounting ID. In case the customer 
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doesn’t have any division number, 00 must be entered instead of 
division number (like 000BED001). Note:  This must be 
UPPERCASE! 

 
 
Leave the Income and Expenses fields blank.  They are not used. 
 
 
Next, click on the Data tab. 
 

 
 
 
Under Item Data Translation, there are two options: 
 

• Export Transactions This option covers how Integrator will export the 
item information to MAS 90.  Translations are done 
using Item Number, UPC Number, Description, and 
optionally the trading partner’s SKU. 

• Imported Transactions This option covers how Integrator will import item 
information from MAS 90.  Translations are done 
using Item Number, UPC Number, or the item 
description.  Note:  UPC numbers are required by 
most trading partners. 

 
Under Addresses, there are two options: 
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• Edit Multiple Store List… This option allows maintenance (and importing) of 

the Store List.  In MAS 90, this is invariably the 
Customer Ship-To Addresses.  As such, we created 
the Ship-To Addresses Export tool under IIG True 
Commerce EDI Customer Options, 

• Edit Dist Center List… As with the Edit Multiple Store List, this allows 
maintenance and importing of the Distribution 
Center information.  The distribution center is also 
almost always in the Customer Ship-To Address 
file.  This allows for generating labels for shipping 
to the distribution center, but marking for specific 
stores. 

 
Edit Lookup Tables… This option allows setting the defaults for this 

trading partner.  We will start here. 
 
First, click on Edit Lookup Tables, 
 

 
 
Select Division Number under Defaults and click the Open button. 
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Enter the Division Number for this customer.  This would be 50 in the example we are 
using (50-BED001).  If you are not using division numbers, then enter 00 as the division. 
 
Click the OK button to save. 
 
 
The remaining Defaults fields: 
 

• Ship Via Code 
• Warehouse 
• Sales Tax Code 
• Terms Code 
• Salesperson ID 
• Confirm to Name 
• Tax Exemption Number 
• Vendor Number 

 
These fields can all be left blank, as the information for them will be defaulted from the 
customer information in MAS 90.  Any value placed in these Defaults Fields will 
override the default values from the customer master file. 
 
Click the Close button to save these changes. 
 
Next, click on the Edit Multiple Store List button to display the Trading Partner Stores. 
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Add  Used to manually add a row to the list for entry. 
Delete  You must first select a row or rows to delete. 
Import Does not work with MAS 90. 
Clear List Clears the entire list.  Good for when you want to import everything. 
Backup Out Exports the list as a CSV file. 
Backup In Used to import the Ship-To Address List from MAS 90, 
 
OK  Accepts and saves the changes. 
Cancel  Cancels any changes.  Any changes you made are gone. 
Help  On line help for this screen.  
 
 
 
Next, click on the Backup In button to import Ship-To Addresses. 
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You will need to navigate to the MAS90 folder and find the TC_BO folder. 
 

 
 
Click on the TC_BO folder and find the trading partner Ship-To addresses you exported. 
 

 
 
Select the file you wish to import and click the Open button.  The import is very fast!  
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Note: The CSV file produced by the Ship Via Addresses Export tool has a very specific 
format.   
 
If you choose to open the file in Excel, we recommend you change the suffix from “.csv” 
to “.txt” which will force Excel to ask you questions about the fields it is trying to import.  
It is very important that you force Excel to treat all of the fields as TEXT fields, so it does 
not try to format the fields for you.  At the minimum, Excel will trash the telephone 
number and Ship-To code fields, which will make the import unusable unless you take 
these precautions. 
 
The Edit Distribution Center List is virtually identical to the Edit Multiple Store List, 
except that you are only importing the Distribution Centers.  After importing the stores, 
then use the Ship-To Address Export Tool to select only the distribution centers and 
export.  You can then import using the Backup In button. 
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Item Data Translation 
 
Click on the Exported Transactions button, which will then request the type of 
transaction: 
 

 
 
Select Purchase Order and click on the OK button. 
 

 
 
Click on the Translation Tab. 
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As with the store lists: 
 
Add  Used to manually add a row to the list for entry. 
Delete  You must first select a row or rows to delete. 
Import Does not work with MAS 90. 
Clear List Clears the entire list.  Good for when you want to import everything. 
Backup Out Exports the list as a CSV file. 
Backup In Used to import the Item/UPC List from MAS 90, 
 
OK  Accepts and saves the changes. 
Cancel  Cancels any changes.  Any changes you made are gone. 
Help  On line help for this screen. 
 
The critical columns are the Translation and User Item ID fields.  These are: 
 

• Translation Either the UPC number or the vendor SKU. 
• User Item ID Your MAS 90 item number.  It must be EXACTLY as you have it 

in MAS 90. 
 
This is what Integrator uses to translate the trading partner PO to your item numbers. 
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You must do the same with the Imported Transactions button. 
 

 
 
Select Invoice and click the OK button. 
 

 
 
Click on the Translation Tab. 
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Integrator uses the UPC# to cross reference the item numbers, and will fall back on the 
description if it can’t match on User Item ID.  So these three fields are critical to the 
system loading the invoice (810 document) from MAS 90. 
 
Once you have loaded all of the items, then Integrator can import the invoices from 
MAS 90.  Click the OK button to save any changes. 
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Exporting Purchase Orders from Integrator 
 
Note:  True Commerce supplies an excellent manual on the normal operations of 
Integrator.  We will not duplicate that here.  We are including a quick overview here only 
for illustration. 
 
Start Integrator, and click on the Get Transactions button to download any new 
transactions from your trading partners. 
 

 
 
Transactions, such as purchase orders, will first appear in the Inbox folder. 
 

 



True Commerce EDI/ASN Link 4.05 36 
 

 
 

INFORMATION INTEGRATION GROUP  877.457.4072 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 
 

 
 
 
Highlight/select the purchase orders you wish to export, and then click the Export button. 
 

 
 
Integrator will export the transactions, along with any error messages and display the 
status in the Information window. 
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Importing Orders in MAS 90 
Now, change over to (or run) MAS 90. 
 
Select True Commerce Order Import from the Sales Order Main menu. 
 

 
 
Process Cycle  Manual or Automatic. 

• Manual In this mode, the program will scan the import directory and 
process all files with the correct file trigger suffix and then exit. 

• Automatic In this mode, the program will scan the input directory at regular 
intervals.  The interval is controlled by the Scan Cycle Units and 
Scan cycle period, which are available only in this mode. 

 
Scan Cycle Units Seconds, Minutes, or Hours.  Available in Automatic mode only. 
 
Scan Cycle Period Number of Scan Cycle Units (1 to 99) to wait before scanning. 
 
File Trigger Suffix The file extension that identifies a file for the program to process. 
   Not case sensitive.  TXT, txt, and Txt are valid.
 
Log to File? The program will create a text log file in the MAS90\HOME 

directory.  All files processed and errors are logged. 
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Detail Logging? This option will record all actions by the import program. 
 
Use Imported Price Will use the price from the purchase order, instead of the 

customer’s MAS 90 price. 
 
Add New Ship To? Adds new Ship-To address if not in the customer’s Ship-To file. 
 
Input Directory Directory to scan for purchase orders to import. 
 
Output Directory Directory where imported purchase order import files are moved to 

when they successfully import.  Import files that have errors will 
remain in the input directory with an “.ERR” suffix. 

 
Path to Integrator path of the Integrator. 
 
Trigger Integrator? If Manual type is specified in the Process Cycle field, this check 

box will be disabled. 
 
Start button Begin scanning the input directory. 
 
 
Note:   In the Automatic mode, to terminate the program from scanning, 

you must click on the X in the upper right hand corner of the 
screen.  The program will then run  the Import Log printing.

 
Once the True Commerce Order Import finishes importing, the Sales Order Import 
Log will start. 
 
 

 
 
Print Prints the log. 
 
Preview Previews the import log.  The user can still print the log. 
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Printer Setup Allows user to change the printer to print to, including deferred 
print. 
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Here is an example of the Sales Order Import Log: 
 

 
 
And the order is now in Sales Order: 
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The Order Date is the Purchase Order date, and the Ship Date is the Requested Ship Date. 
The correct Ship-To Address is loaded, if possible. 
 
Here are the items: 
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Note the comment lines with the Requested Ship Date and Cancel After Date.  If supplied 
from the trading partner, the Do Not Ship Before Date will also appear as a comment.  
All three fields are also available to Crystal Reports. 
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Exporting Invoices from MAS 90 
 
From the Sales Order Main Menu, select True Commerce Invoice Export. 
 

 
 
 
Invoice Number All If checked, will select all un-exported EDI invoices. 
 
Invoice Number Starting Starting invoice number of the range. 
 
Invoice Number Ending Ending invoice number of the range. 
 
810 Export Directory Directory where the invoices (810 document) will be 

exported.  This defaults from the True Commerce Options 
Setup. 

 
 Used to select the 810 Export Directory. 

 
Proceed Starts the export. 
 
Printer Setup Allows the user to select printer or to print deferred.  Note:  

There is no Preview on this report.  You must either print to 
Deferred Print or to a Printer. 

 
Click on the Proceed button to begin the export. 
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If the Invoice has not been exported before running the S/O Daily Sales 
Report/Updates, it can be exported after update using the True Commerce Invoice 
History Export program. 
 
Only the invoices of the customers checked as EDI Customer can be exported. 
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Importing Invoices into Integrator 
 
Switch to or start Integrator, and select the Outbox folder. 
 

 
 
Integrator will then import the invoice transactions from MAS 90.  Any warnings or 
errors will be shown in the Information window. 
 

 
 
If Integrator shows a Stop Sign, that transaction will require correcting one or more 
fields. 
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In this example, the Address tab is highlighted in Red.   
 

 
 
This must be corrected before Integrator will allow you to send this Invoice. 
 
Click on the highlighted tab. 
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The required field that must be filled in is highlighted.  Enter the missing value. 
As soon as the missing value is entered, the highlight is removed and the problem is 
corrected. 
 

 
 
Click OK to save the changes. 
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Now the Invoice is ready to send.  You can also use this invoice to generate an ASN and 
labels.  Please see the True Commerce manual on how this is done. 
 
That’s all there is to it!   



True Commerce EDI/ASN Link 4.05 49 
 

 
 

INFORMATION INTEGRATION GROUP  877.457.4072 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 
 

ASN Processing (Advance Ship Notice) 

IIG True Commerce ASN (856) Export 
The IIG True Commerce ASN (856) Export program has 
been added under the Sales Order Main menu to enable 
ASN functionality in the True Commerce EDI Link.  
 
Note: This program will not work if the Enable TSA check 
box is not selected in IIG True Commerce EDI Options. 
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The 856 Export Directory is the directory where the 
Advance Ship Notice (856) will be exported. 
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Customer Maintenance  
Click the EDI button on the Additional tab of the 
Customer Maintenance to open the IIG True Commerce 
EDI Customer Options screen.  
 
Check the Requires ASN? box on the IIG True 
Commerce EDI Customer Options screen.  
 

 
 
Note: The Requires ASN? check box will not be visible if 
the Enable TSA check box is not selected in IIG True 
Commerce EDI Options. 
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Sales Order Entry 
The TCE EDI button will be shown on the Totals tab of 
the Sales Order Entry for EDI customers.  
 

 
 
Note: The TCE EDI button will not be visible if the Enable 
TSA check box is not selected in IIG True Commerce EDI 
Options. 
 
Click the TCE EDI button to enter the shipment data.  
The IIG EDI ASN Shipment Entry will be opened for 
entering the necessary information. 
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The Carrier SCAC Code is the Standard Carrier Alpha 
Code for the Carrier set in the Shipping Rate 
Maintenance. 
 

 
 
The Estimated Delivery is the date the shipment is 
expected to arrive. 
Enter the data and click OK. 
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Shipping Data Entry 
 
Run the Shipping Data Entry. The TCE EDI button will 
be shown for EDI Customers. 
 

 
 
Note: The TCE EDI button will not be visible if the Enable 
TSA check box is not selected in IIG True Commerce EDI 
Options. 
 
Ship the Sales Orders created for EDI customers and run 
the True Commerce ASN Export program under the 
Sales Order Main menu. 
The IIG True Commerce Advance Ship Notice (856) 
Export screen will be displayed. 
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Select the 810/856 Export Directory that is the directory 
where the Advance Ship Notice (856) will be exported and 
Proceed.  
The following .txt file will be created and saved in the 
selected folder. 
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Batch Invoice Transfer Utility 
 
The Batch Invoice Transfer Utility program has been 
added under Sales Order Shipping to allow moving an 
Invoice from one batch to another. 
 

 
 
Select a line in the first greed then click the Copy button to 
move it to the second one. 
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Glossary 
 
 
810 Invoice document.  Your billing to the trading partner. 
832 Catalog document.  Required by some trading partners, this 

is an electronic catalog of what you have to sell. 
850 Purchase Order from your trading partner, it becomes a 

Sales Order in your system.  If you send it to a trading 
partner, it is a Purchase Order from your system. 

856 Advance Ship Notice.  Used to advise the trading partner of 
product shipped and on the way. 

ASN Advance Ship Notice.  Also 856 Document. 
Bar Code Printer Machine (usually a thermal printer) used to print ASN and 

Shipping Labels.  Required by most trading partners for 
scanning and legibility. 

Bartender Bartender Bar Coding program from Seagull Scientific.  
Used to generate the labels for Integrator. 

BSP Business System Plug-in.  The interface between Integrator 
and MAS 90. 

Integrator The user interface for the True Commerce EDI.  This is 
what you receive the transactions though and send from. 

TC.NET The Value Added Network used by Integrator. 
TCE True Commerce EDI.  Our module code for this 

enhancement. 
VAN Value Added Network.  How EDI transactions are sent and 

received. 
Vendor Compliance Labels Another phrase by trading partners for ASN and packaging 

labels.  Printed by the Bartender software. 
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